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Chapter 1 – Introduction 

What is RMT? 

RMT, short for Raid Management Tool, was conceived and created in April 2002 by Clerule and 
Mern from the E’ci Server.  Most public raids take on average between 30 to 60 minutes to 
gather up and prepare for the encounter.  The use of paper and pencil, coupled with manually 
tracking the raider’s attendance, raid points, takes an enormous time for both the raid leaders 
and his assistants. 

But not any more… 

RMT was created to facilitate group creation, attendance tracking, loot awarding, raid points 
tracking, and sharing of raid information via XML. 

RMT’s Home page is at:  http://www.sincioco.com/rmt3/

Note:  This documentation is updated as of RMT 3.0 Build 40 which was released on September 
11, 2003. 

Announcing Your Raid 

Find a message board that your guild or server uses and announce your intent to raid.  Give the 
date, time, duration and objectives for the raid and ask people to sign up. 

Please note that this does not mean other people in your server will honor your intent to raid in 
the specific date/time of your choosing.  However, this approach of announcing one’s intent has 
worked extremely well on the E’ci server. 

Announce and Honor System 

Everyone can benefit greatly from an announce and (hopefully) honor system.  Raid leaders 
should start announcing their intent and allow others who have announced their raid in advance 
to proceed without molestation.  It only takes a few well-intent raid leaders for this sort of 
system to develop in your server.  Try it! 

To see how the E’ci Sever’s public raids are announced go to: 

http://vnboards.ign.com/board.asp?brd=5429

http://www.sincioco.com/rmt3/
http://vnboards.ign.com/board.asp?brd=5429
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Raid Sign Up 

Even if you plan to lead a private raid for your own guild, it is still recommended that you post a 
Raid Sign Up message in your guild’s message board.  This will give you a better idea of the 
number of people who plan on being there, and the average level—in short the effective force of 
your raiders.  Of course, for guilds that raid every day, this will be unnecessary.  Use the EQ Log 
Parser in this case. 

Below is an example of an actual weekly Public ToV (Temple of Veeshan) raid on the E’ci Server: 

To Do:  Show a picture of a raid sign up. 

Raid Attendees 

Gather the name, class, level and guild of players who are signing up.  Below is an actual raid 
sign up of a Public ToV raid on the E’ci server. 

To Do:  Show a picture of a person who signed up. 
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Chapter 2 – Getting Started 

Getting Started 

Once you’ve announced your raid and you have people who have signed up, you are ready to 
use RMT. 

 
Figure 1:  New Raid Dialog Box 

To get started do the following: 

1. Start RMT. 

2. Click on the File menu and select New Raid… 

The New Raid dialog box appears (see Figure 1:  New Raid Dialog Box). 

Here are the explanations of the fields being asked in the New Raid dialog box: 

Zone – The zone that you will be raiding in.  This is important to decide in 
advance, as loots you collect on this raid will be associated to this particular 
zone. 

Date – The date of the raid.  In what day, month, year will the raid be? 

Time – The time of the raid. 

Duration – How long will the whole raid take.  This should include preparation 
time and actual raid time, so people know precisely how much time it will take. 

Time Zone – Which time zone?  Not everyone lives in the same geographic 
region. 
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Raid Leader – The person who will lead the raid, which may or may not 
necessarily be you. 

3. Click OK once you are done setting up your raid. 

If after clicking OK you realized you’ve made a mistake and wish to correct your mistake, simply 
go to the Edit menu and select Raid Information… and make the appropriate corrections.  (Note:  
Once you have started the raid and have started getting loots, you can no longer change the 
zone name as the loots are associated with the zone.) 

First Time Users 

If you are new to RMT, familiarized yourself with the user-interface and how RMT works before 
using it in a real raid.  In other words, do your homework and test RMT to see if it will perform to 
your satisfaction.  The worst time to find out that RMT is not the tool for you is during an actual 
raid. 

As a new user, it is recommended that you type the raid attendees manually, one by one.  Do 
not fret.  RMT was created to save you typing in the future.  In the future, as soon as you type 
the first few letters of the player’s name, RMT will automatically recall the player’s class, level, 
guild so you don’t have to re-type them.  But for now learn things the hard way first, so that you 
can later appreciate the easier ways. 

If you really are keyboard-challenged, you can use the RMT’s Real-Time EQ Log Parser.  Have 
your raid force be in the same zone, and type “/” or “/who” in EQ.  The name, class, guild, level 
that EQ returns will get fed into RMT in real-time, this will allow you to individually select the 
players you want to include in your raid (more on this later). 

If you’ve inherited an RMT database with previous raids already saved, you can select players 
from the All Players window and drag them to the Attendee window or the Group window.  This 
will save you a lot of typing. 
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Figure 2:  A new raid. 

If you had specified a Raid Leader in the New Raid… dialog box, notice that the raid leader 
appears as an attendee of the raid.  Since this is the first time you are using RMT, the raid 
leader’s class, level and guild would not be known to RMT at this point—in the future it would be 
automatically be pre-filled for you. 

Updating the Raid Leader’s Information 

To update the raid leader’s information, do the following: 

1. Select the raid leader from the Attendees. 

2. Type or select the raid leader’s level. 

3. Type or select the raid leader’s class. 

4. Type the raid leader’s guild name. 

5. Click the Update button. 

RMT will now permanently remember the raid leader’s information.  This will ensure that in future 
raids, you do not need to re-type the raid leader’s class, level and guild.  You can, update any of 
this information at any time by following the steps described above. 
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Adding Attendees to the Raid 

Add the rest of the attendees to the raid, one-by-one, by doing the following: 

1. Click the New button. 

2. Type the attendee’s name. 

3. Type or select the attendee’s level. 

4. Type or select the attendee’s class. 

5. Type the attendee’s guild name. 

6. Click the Add button. 

As painful as it may be to have to type 40-60 names, class, level guilds the first time around, 
please be advised that this is the ONLY time you will be typing all these players and their 
associated information. 

In future raids, if the same person signs up, their class, level and guild will automatically be 
recalled after you type an attendee’s name.  You do not even need to finish typing an attendee’s 
name—RMT will try to auto-match the first few characters with a name in its internal list. 

You can update any attendee’s class, level and guild at any time in exactly the same way you 
update the raid leader’s information in the previous section (see page 9). 

Internal Lists 

RMT keeps track of an internal list of attendee names, classes, guilds, levels, attributes, time 
zones, and many more.  You can think of this internal list as sort of a phone book.  Whenever 
RMT thinks you are trying to re-type the same information, it will recall what it has stored 
internally to save you the typing.  Of course, you can override this internal list by simply 
continuing to type. 

Internal Lists in Action 

To show the internal list in action, create a new raid with the same raid leader as before.  RMT 
will even remember who the last raid leader was, so you do not need to re-type it. 

Notice that the blank raid created has the raid leader’s class, level and guild filled in for you (that 
is, if you provided this information in the past).  In fact, if you start typing the same attendee 
name whose class, level and guild you have typed in previously from another raid, RMT will recall 
all those information for you too.  This will save you A LOT of time in future raids! 

Veteran Users 

Former users of RMT know that they never had to re-type previously stored raid information from 
one version of RMT to the next.  Use the Data Migration Tool to migrate (or copy) data from a 
previous version of RMT. 

To launch the Data Migration Tool, click on the Tools menu and select Migrate Data from 
Previous Versions of RMT (Ctrl + M is the shortcut key). 
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Data Migration Tool 

The Data Migration Tool allows RMT data to be copied from one database to another.  All raid 
information is stored in RMT3.mdb (a Microsoft Access 2000 database). 

 
 

 
Figure 3:  The Data Migration Tool. 

You can also use the Data Migration Tool to import data from the Sample.mdb database.  The 
Sample.mdb raid stores actual raid information from Clerule’s public ToV raid (although the raid 
points were added later to make the sample database more useful). 

Attributes, Player Notes, Time Zones, Timers, Player’s Hidden Status are also imported. 
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How to Copy a Raid 

You can export and re-import a raid from an XML file to make a copy of it.  Here’s how you do it: 

1. Open the raid you want to copy. 

2. Go to the File menu and select Export Raid as XML File. 

3. Save the XML version of the current raid. 

4. Go to the File menu and select Import Raid from XML File. 

5. Select the XML file you just saved. 

6. Click on Import. 

Once the import process has completed, you would have copied the raid you have saved. 

Players Notes are appended to any pre-existing notes if they differ.  RMT will also ignore the 
Total Raid Points saved in the XML file, since it is dynamically calculated. 

How to Rename a Raid 

You cannot rename any raid if there is any loot that has been awarded.  This is because loots are 
tied to zones.  If you suddenly change to a different zone, RMT will not know if the existing loots 
are also found in that zone.  RMT was not designed to be used in a zone-roaming scenario. 

To rename a raid, do the following: 

1. Select Remove All Loots Awards from the Tools menu. 

2. Click on Raid Information… from the Edit menu. 

3. Modify the raid information. 

4. Click OK. 

When doing a zone-roaming raid (such as when doing epic nights), you can copy the raid first 
then rename the copied version to a different name.  That way, you don’t need to re-create the 
groups whenever you go to a different zone. 

Show the Data Migration Tool in action. 
Show the auto-look up feature to save typing. 

Real-Time EQ Log Parser 

RMT’s real-time EQ Log Parser is a great tool to have during impromptu raids.  By simply typing 
“/” or “/who” RMT will automatically read your EQ Log to parse out the names of the people that 
show up, so you don’t have to type their name, class, level, guild.  In fact, this works outside of 
the current zone too, so you can type “/who 60 65 all lfg”. 

For the EQ Log Parser to work, your character in EQ must have logging turned on.  To do this 
type, “/log on” in EQ. 
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Figure 4:  EverQuest Log File Parser (real-time) 

To use RMT’s EQ Log Parser, do the following: 

1. From the File menu, select Import Players from EQ Log. 

2. Click on the Browse… button and select your character’s EQ Log. 

3. Type “/who” in EQ and watch RMT parse the names in real-time. 

4. Select the player(s) you want to be included in the raid. 

5. Click the Import button. 

Players whose class, guild and level is not provided such as when filtering players in chat 
channels can be determined by RMT in real-time by looking at the information stored in the All 
Players list.  Meaning, if Clerule is anonymous or is in a chat channel, RMT will look up Clerule’s 
last known class, level, guild and pre-fill it for you automatically.  This will save you a lot of 
typing in the future! 
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Show importing guild members only. 
Show importing players in the same zone. 
Show importing players in the same chat channel. 

Importing Guild Roster 

You can import the “guild dump” that EQ’s Guild Management Tool creates.  This will completely 
save you from having to type all of the members of your guild into RMT. 

To import your guild roster, do the following: 

1. From the File menu, select Import Guild Dump from EQGMT. 

2. Click the Open button and select your guild dump file. 

3. Click the Import button. 

RMT will create a raid with a name “Guild Roster.”  You are free to rename this as you wish, but I 
would suggest keeping it as a permanent record of your guild’s Roster as of that date.  Re-
importing your guild’s roster on a monthly/quarterly basis from the guild dump file may be a 
good way to make sure everyone in the guild is in RMT. 
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Figure 5:  Import EQ’s Guild Dump. 
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Figure 6:  A fully created raid. 

Raid Force Creation 

Unless you are in an uber-guild capable of setting up groups in 5 minutes with mass group buff 
capability, you will need to setup groups well in advance.  Once you have a list of players, and 
their classes and levels, you can begin creating groups. 

Group Creation 

How you create your groups will defer from raid to raid.  Typically, a group will have a cleric, and 
optimally a backup druid/shaman for patch healing.  If you need to take on hard-hitting mob, you 
may end up creating a group (usually group #1) with the MT (main tank) in it and 5 other clerics 
(in the same group) to make it easier to do complete heal cycles.  This also makes it easy for 
each cleric to see each other’s HP for cross-healing each other.  If your guild is big enough, you 
can create another group (usually group #2) with the ST (secondary tank) and another 5 clerics 
in it.  The rest of the groups can be healed by druids/shamans. 
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The easiest way to create a group is via dragging and dropping.  You can drag players from the 
Attendee window to any of the groups in the Group window.  You can also drag and drop players 
from the All Players window to either the Attendee window or to any of the groups in the Group 
window. 

1.) Drag and Drop from Attendee to Group 

 a.) Show a full group get created via drag and drop. 

2.) Drag and Drop from Group to Group 

 a.) Show groups getting rearranged. 

Assigning Raid Leader (RL), Group Leaders (GL), etc. 

A raid is not a raid unless you’ve got people to lead it.  A raid leader can be assigned by simply 
right-clicking the new would-be raid leader and selecting Raid Leader (RL) from the drop down 
menu.  The same steps apply to assigning Main Tank (MT), Secondary Tank (ST), etc. 

 
Figure 7:  You can assign multiple attributes to players. 

In general, pick a GL that you know will be in the raid.  The same is true for the MT and ST.  In 
otherwords, do not always pick the highest level person in the group to be the GL.  Pick the most 
reliable person who you know will be in the raid on time.  This will generally speed up raid 
preparation. 

 a.) Show players gets assigned one or more attributes. 

 b.) Show that the color coding shows up in other windows. 
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Posting Groups on the Web 

Once your groups have been setup it would be a good idea to post it in your guild’s message 
board or to a public message board so the raiders know who is in and who is out.  Group leaders 
typically print out the list so that when the day of the raid comes they know precisely who their 
members are.  If buffers and debuffers have been selected ahead of time, it will help everyone 
know ahead of time who will cast KEI, or who will slow the mobs. 

Show RMT's web export functionality 
Show the ability to include/exclude guild name and raid points. 
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Chapter 4 – During the Raid 

Getting the Raid Started 

Before you send your raid force to either death or victory (the latter is preferred), finalize your 
groups and designate people to be the buffers and de-buffers. 

Mark those who did not arrive as No Shows, and those who arrived late⎯15 minutes or later is a 
good mark⎯as Late. 

No Shows should be removed from the raid, as they serve no purpose—unless you want to keep 
track how many times a player did not show up.  This can be easily tracked later via the Player’s 
Raid and Loot history, just count the number of times they are in a raid but was not grouped! 

Show a player being marked as Now Show. 
Show a player being marked as Late. 
Show a player being removed from the raid. 

Awarding Loots 

 
Figure 8:  The Loots window. 

The single most rewarding aspect for raiders (aside from seeing the mob drop and not dying) is 
seeing loots drop.  The sing most rewarding aspect for a raid leader is to award loots that 
dropped.  Let’s face it, the whole purpose of raiding is to get loots⎯and lots of it! 
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To award a loot, do the following: 

1. Click the Loots icon on the toolbar to bring up the Loots window. 

2. In the Name drop down list, select the player who will receive the loot. 

3. In the Item drop down list, type or select the loot to be awarded. 

4. In the Cost text box, type the cost of the loot (this is optional). 

5. In the Stats text box, type the stats of the loot (this is optional). 

You can type any HTML/JavaScript/VBScript in the Stats text box.  A good use this 
feature is to a image reference to a screen shot of a loot.  There are plenty of web sites 
with screen shots of the stats of loots such as from EverLore.com. 

Here’s an example of a HTML code that references the Adamantite: 

<img src=”http://www.everlore.com/files2/ITM_9712_164778.jpg”> 

6. Click the Add button. 

Show how to award a loot to a player. 
Show how to award a loot to a player with loot stats. 
Removing an award from a player (show how this affects their total raid points). 

Assigning Cost to Loots 

Not all loot should be valued the same way.  By assigning values to loots and publishing these 
values publicly everyone can gain a better understanding on what it takes to earn certain loots. 

Some guilds decides who gets what loot by seniority (length of time they have been in the guild, 
or length of need), others by a more objective way such as by using a Raid Points System (RPS). 

Assigning a cost to a loot is fairly easy.  First, you must already be in the processing of awarding 
a loot to a player (see previous section) or you must be editing a loot that has been awarded.  
Simply type in the loot cost in the cost text box and hit either Add or Update.  Viola! 

Show to how assign cost to loots. 
Show to how modify loot cost for all instances of the loot.  (Multiple Update.) 

Pre-setting Loot Costs and Stats 

RMT was not designed to be a Loot Management System, hence it has no facility for managing 
loots outside of awarding one.  If you need to pre-assign loot costs and stats well in advance, I 
would suggest doing the following: 

1. Create a raid.  Name it appropriately with something like “Temple of Veeshan.”  
Remember, the loots are tied to the Raid/Zone name. 

2. Create a player.  Name the player appropriately with something like “GuildLootMaster” or 
“GuildLootCost.” 

3. Award the player all loots whose stats and costs you want to pre-determine. 
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The next time you start a raid in the “Temple of Veeshan” zone all the loot stats and cost would 
already be set, so awarding a loot would that much easier. 

Raid Points 

Awarding loots to players by using some sort of Raid Points System (RPS) is perhaps⎯in my 
humble opinion⎯the most objective way of doing it.  As long as the rules that govern how raid 
points are earned are understood by everyone and do not change too much over time (so think 
of the rules deeply before implementing them), everyone who hates the rules will begin to like it 
as they accumulate raid points. 

You can think of raid points as money, the more points people have the happier they are, and 
the more likely they will stay in the guild as they will feel they’ve got plenty of raid points 
(money) invested in. 

Assigning Points to Player(s) 

Some raids/guilds make their raiders earn points on a per 30-minute cycle.  So, for example, if a 
player stays 2 hours, that’s 4 raid points.  Others, designate a specific raid as being worth a 
specific raid points.  For instance, a raid leader could make a ToV raid worth 8 points regardless 
of how long the raid takes.  How users earn raid points is completely at the discretion of the raid 
leader/guild.  RMT makes no assumptions about how raid points are earned, it simply keeps track 
of it. 

 
Figure 9:  Raid Points window. 

Here’s how you assign raid points in RMT: 

1. Start RMT and open a raid. 
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3. Select the player(s) whose raid points you want to modify. 

4. In the Action drop down list, select whether you want to add, subtract, or assign raid 
points to the selected player(s). 

Add ⎯ means you want to add in addition to the current raid points. 

Subtract ⎯ means you want to subtract from the current raid points. 

Assign ⎯ means you want to just assign a specific raid points value. 

In the Points text box, type the number of raid points to assign. 

You may type integers (like 10) or decimals (like 1.1111). 

5. Click the Update button. 

Notice that the player’s Total Raid Points will be recalculated.  Depending on the number of 
players you’ve selected, recalculating everyone Total Raid Points could take a little while. 

Show assigning raid points to all players (in the raid). 
Show add/subtract raid points to speicific players. 

The Meaning of Total Raid Points 

Total Raid Points can be likened to your bank account’s balance.  It answers the question of “how 
money do you have in the bank?” or “how much money can I spend?” 

It essentially means this: 

Total Raid Points = All Raid Points Earned – All Loots Awarded 

In other words: 

Account Balance = All Deposits – All Withdrawals 

However, unlike your bank account, RMT will permit negative Total Raid Points or negative 
balance. 

Total Raid Points is recalculated by RMT in real-time whenever you perform actions that may 
affect it.  Such actions may include but are not limited to: 

• Deleting a raid. 

• Adding, editing, deleting players. 

• Adding, editing, deleting loot awards. 

• Importing via XML or the Data Migration Tool. 

Next time you think RMT is running a bit sluggish, think about it⎯it’s doing all the number 
crunching for you on your behalf so you can continue to lead raids briskly and generate wonder 
reports! 
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Player Notes 

Players Notes are an excellent way of keeping track of what epic pieces a player still need or 
maybe a hyperlink to the player’s picture or Magelo profile.  It’s also a good way of keeping track 
of players who fall asleep in raids or players who simply would not want to re-invite. 

 
Figure 10:  The Player Notes window. 

You can type HTML, JavaScript and VBScript in the player notes! 

Notes are automatically added by the following: 

When a player is renamed.  RMT will note both the old and new name in the player’s note. 

When an XML file is imported.  If the player’s note differs, the note being imported will be added 
to the existing one. 

When a Data Migration happens.  If the player’s note differs, the note being imported will be 
added to the existing one. 

Using notes to enter player's needed epic pieces. 
Show how to enter simple text notes. 
Using notes to enter player's magelo profile. 
Show how to enter HTML notes. 

Timer 

You can set up countdown timers in RMT which can be used to time when mobs are due to 
spawn or when buffs are due for a refresh. 
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Figure 11:  The Timers window. 

Show how to enter a few group buffs. 
Show an expired timer (just before it expires). 
Show the number of active timers on the status bar. 
Timing mob spawn. 
Show how to enter a few mob spawns. 
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Chapter 5 – After the Raid 

Sharing Raid Results 

 

Sharing Raid via XML File 

 
Figure 12:  XML Export window. 

RMT supports exporting and importing of XML files.  XML files are small and readable and are 
great for sharing raid information either via email or via the web. It is the preferred method of 
sharing raid information amongst raid leaders and officers. 
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Show an XML file being saved and emailed. 

Posting Raid Results on the Web 

 
Figure 13:  Web Board Posting Export window. 

Whether it is a public raid or a guild raid, posting raid results on-line is generally welcomed for 
the following reasons: 

1. People want to know who got what loot. 

2. People want to know how much raid points they earned and how much they have total. 

3. People want to know who actually attended the raid. 

Show a raid result being posted on the VNBoard. 
Show a raid being export to XML and sent via email. 
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Viewing Player's Historical Data 

 
Figure 14:   Raid and Loot History window. 

One of the key strengths of RMT as a raiding tool is it’s ability to keep track of player’s historical 
raid attendance and loot awards.  Without much effort on the user’s part (aside from keeping 
data accurate), RMT will automatically gather historical information in an easy to read manner.  
And best of it, it can be exported into Microsoft Excel for easy record keeping. 

Show a few player's historical data from different windows. 
Show Export to Microsoft Excel. 
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Viewing Loot's Historical Data 

 
Figure 15:  Loot History window. 

RMT also keeps track of who has been awarded a particular loot in the past. 

Show a few loot historical data from different windows. 

Exporting Data to Microsoft Excel 

RMT makes available to Microsoft Excel pretty much all it’s raid information.  With only a few 
mouse clicks, you can have a good-looking Excel spreadsheet you can use to do further number 
crunching or send off to an overly curious guild member or raider (presumably asking about their 
raid points total). 

Show a player's raid/loot history being exported. 
Show a loot's award history being exported. 
Show the raid's attendees being exported. 

Importing Raid Information 

There a few ways of importing raid information into RMT.  One is via XML files and the other is 
using the Data Migration Tool. 

Sharing raid information via XML is by far the easiest and best way to share raid information 
amongst raid leaders and officers.  It is small and it is a text file which can be viewed in either 
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Notepad or Internet Explorer.  You will not lose any information if you export raids as XML.  
Players Notes are also exported and will automatically be appended to existing notes during the 
import process. 

The Data Migration Tool was designed specifically for migrating data from one version of RMT to 
another, although it can also be used for copying/cloning raids, as well as sharing raids with 
officers and raid leaders.  The downside to using the Data Migration Tool is that it requires the 
sender to send their RMT3.mdb file which can large over time. 

1.) Importing raid information from the web. 

a.) Show how to grab posted information from the web and import it in RMT. 

 2.) Importing raid information using the Data Migration Tool. 

  a.) Show how to grab information from an emailed RMT3.mdb. 
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Chapter 6 – Miscellaneous 

Manually Recalculating Total Raid Points 

RMT generally automatically calculates the Total Raid Points in real-time as you perform actions 
that may affect it.  Power failures, or your PC being inadvertently rebooted may cause raid points 
to become inaccurate overtime.  To ensure data integrity, RMT periodically recalculate raid points 
for you. 

You can have RMT recalculate the Total Raid Points at any time by doing the following: 

1. Click on the Help menu. 

2. Select Recalculate Raid Points. 

 a.) Show how to manually recalculate raid points. 

Checking for New Versions of RMT 

When you start RMT, it will automatically check for a new version of itself.  When a new version 
is found, it will automatically open a browser with in RMT to inform you.  RMT will keep opening 
this browser every time you start RMT until you upgrade to the new version. 

Show RMT at start up checking for a new version. 
Show how to manually check for a new version. 

Uninstalling RMT 3.0 

Alas, you have to uninstall RMT at some point.  Perhaps, you have resigned your post as a raid 
leader, or you’ve been booted out of your officer ship.  :-p  Whatever the reason, RMT can be 
un-installed from Add/Remove control panel applet. 

When you uninstall RMT 3.0, your RMT3.mdb (your data) will still be intact. 

Show RMT getting uninstalled RMT. 
Show that the RMT3.mdb is still intact. 

RMT and Visual Basic 6.0 

RMT 1.0 and 3.0 were both made using Microsoft Visual Basic 6.0 (SP5) with Microsoft Access 
2000/XP.  The MS Access database is in the 2000 format, but I use MS Access XP to modify/edit 
it. 

Show RMT in Visual Basic's IDE. 
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